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About this Guide

This guide helps you start using the K1205 with version 2.30 software.
You should be already familiar with signaling protocols. Refer to the
K1205 online help system for more information about using the K1205.

NOTE. Some of the screen shots have been modified and might not appear
in exactly that form on your screen.

Explanation of the symbols and abbreviations used in this guide:

Text style Description

-> Refers to a menu name or entry

RMC Right mouse click

LMC Left mouse click
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Installing K1205 Version 2.30
K1205 Version Upgrade

Existing configuration files created by older versions of the K1205
software are - dependant on the stack - compatible with version 2.30. You
should therefore save your configuration files before installing the new
K1205 version.

K1205 Software on a PC

You can install K1205 Software on a PC running Windows 98 SE,
Windows NT 4.0, or Windows 2000. You can either install the Record
Viewer, which is provided on your K1205 software CD, or you can obtain
the PC Monitoring Software, which has a wider range of features.

Record Viewer 

The Record Viewer allows you to do the following:

� View recording files

� Print recording files

� Filter or zoom the recorded data stream

� Edit or create protocol stacks

The functionality of the protocol stack editor and of the online help is not
restricted. If used on your PC, the setup routine will require your K1205
serial number and the file keyfile.txt 1 must be copied from the K1205
keyfile diskette to the PC.

PC Monitoring Software 

The PC Monitoring Software package allows you to analyze K1103,
K1205, and K1297 recording files off-line on your Windows NT or
Windows 2000 PC. The software includes the full functionality of the
Offline Scenarios pipeline and the Record Viewer pipeline including all
standard K1205 applications, statistics, filtering, and triggering functions
(refer to section Online and Offline Pipelines).

1 The file is located in C:\WINNT on your K1205
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Monitoring with K1205 Version 2.30

This chapter describes most of the features of the K1205 and gives
examples of how to use them.

Starting K1205 Version 2.30

After switching on the K1205 the software starts automatically (if this
feature was selected during installation). You can start the K1205 software
manually by double-clicking on the K1205 icon.

Status Window

The first window that opens is the K1205 Status Window, which displays
the status of the hardware installation and the boot process.

Figure 1: K1205 Status Window

Right Mouse Click (RMC)

Instead of using the menu entries or toolbar buttons, you may use the right
mouse click (RMC) anywhere in the program to shortcut certain functions.
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Data Flow Window
The main window is the Data Flow Window which contains a graphical
display of configured measuring tasks, called online and offline scenarios.
Each scenario may contain several pipelines for the specific measuring
tasks.

The left part of the window contains a list of all the scenarios, each
corresponding to a pipeline in the right part of the window. The scenarios
define such things as interface, port, timeslot, and bit-rate for the
connected link.
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Figure 2: Data Flow window with pipelines
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Online and Offline Pipelines
Different online and offline pipelines are available. Choose one, and drag
it into the right window to create a new link, or connect it to an existing
link.

Drag and drop

Figure 3: Pipeline buttons

Online measurements monitor live data as it is received; the K1205 is
connected to the links being monitored. Offline measurements use data
stored in recording files.

Online Pipeline: “On Monit”. Online monitoring means analyzing data online
in the Monitor window. The pipelines are activated (and the measurement
is started) by clicking the ON/OFF switch in the Measurement Window.
This works only if they are set up correctly. (refer to section Manual
Configuration)

Figure 4: Online monitor pipeline switched ON
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Online Pipeline: “On Record”. Online Recording means writing live data to a
recording file. You can define recording files (the procedure is identical
for online and offline pipelines) by clicking the  or  button.

Figure 5: Online recording file pipeline switched ON

The following Recording Write Configuration window is displayed.

Figure 6: Recording Write Configuration window (Multiple Files selection)
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Overwrite mode is the default if there is an existing file that can be
overwritten. 
Append mode is used to add data to the end of an existing file.

CAUTION. A necessary prerequisite when using Append mode is, that the
configuration of the pre-recorded data is the same as the one of the data to
append. All old configurations (such as link-settings) will be overwritten.

You can choose the size of the recording file and the total number of files
used during a single session. For multiple files you can select the rule for
creating a new file. New files will be created after

� a certain size has been reached

� expiration of a certain time period

� closing of the switch.

Next, choose the maximum number of files to be created and the
format/mask for numbering of the filenames.

NOTE. Recording files are limited to 2 GB space.
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Recording files can now be concatenated to create a single file out of two
or more. You can thus have all relevant data from several pipelines in one
recording file: use the Recordfile Merger tool, which is in c:\k1205\tools
directory.

Figure 7: Recordfile Merger tool
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Offine Pipelines. The playback pipeline Off Monit can playback pre-re-
corded files in real-time (as if online) or with a defined speed. With this
feature you can view a recorded file offline with exactly the same
conditions as if it were online. Applications (such as calltrace or
sequencing) and filters may also be used.

Figure 8: Active playback monitor pipeline

To play back a file, select the desired file in one of the offline pipelines by
clicking the Open button. The File Open dialog box should pop up. The
file type can be either from K1205 (.rf5), K1103 (.rec) or K1297 (.dat).

To start or continue the playback, click the triangle (play) button. To stop
the playback, click the square. To pause, click the double lines. You can
change the setup (playback speed) by clicking the  button.

The data is now shown in the Monitor window. To switch to the Monitor
window, click the monitor symbol in the appropriate pipeline.

The Record Viewer allows you to scroll through a pre-recorded and
decoded file. You can define filters for the screen output, but applications
are not available.

Open / Close

Figure 9: Record viewer pipeline
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The Offline Recording Pipeline allows you to re-record files after
processing them offline with applications or filters. Set up the recording
file the same way as described further above for the online pipeline.

Figure 10: Offline recording pipeline
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Scenarios
The Measurement Scenarios tab of the Data Flow Window displays the
current configured measurement scenarios and sources. This tab keeps you
informed about the currently active parameter settings and system state at
all times. The gray boxes in the pipelines represent measurement modules,
and the connecting lines indicate the data flow between modules.

You can also perform all operations in the Data Flow Window via the
Scenarios RMC menu (refer to section Manual Configuration, Figure
Change the scenarios):

� Configuring, renaming and removing scenarios

� Assigning, editing and removing pipelines or pipeline branches

� Adding, editing and removing logical links

Functions that are not available in the current situation are deactivated.
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Capture RAM

The Capture RAM allows you to define the memory area reserved for
buffering signaling data on the interface modules, either limiting the
amount of data (Linear Mode) or writing received data continuously into
the capture RAM (Ring Mode).

Figure 11: Capture RAM symbol and configuration

You can specify criteria for writing data to the capture RAM in the input
filter. You can set the size of the capture RAM anywhere between 16 KB
and 4096 KB (4 MB).

For example, if during a measurement an unexpected error suddenly
occurs, but the recording pipeline is not activated, saving the Capture
RAM will store this data for later processing in a Recording file: RMC on
the capture RAM symbol → Save Capture RAM.
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Configuration
Autoconfiguration

Using Autoconfiguration. The easiest way to configure the K1205 is by
pressing Autoconfiguration  after the K1205 software has started.
Connected traffic to whether signalling in SS#7, LAPD / LAPV, Abis or
TRAU is running on E1/T1 is detected automatically.

After autoconfiguration, only the protocol stacks have to be set in order to
define how to decode the input data (refer to section Manual Configura-
tion).

If Autoconfiguration  is not selected, choose a saved configuration or the
default configuration. In this case you will have to configure the connected
links manually (refer to section Manual Configuration).

After that has been done you can activate the pipeline (LMC on the switch
symbol of the pipeline), and start decoding (LMC on the monitor symbol
of the pipeline).

Switch-Symbol
Monitor-Symbol

Figure 12: Monitor pipeline switched ON
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Autoconfiguration Wizard. This feature allows you to limit the scan of the
autoconfiguration to specific signaling types, ports and channels. In
addition, the assignment of logical links to online scenarios is controlled.
You can create and load different strategies depending on the measure-
ment.

The K1205 is delivered with a standard strategy, standard.stg. It is used if
there is no other strategy in the system. You can use this file to create your
own strategies.

For example, if you use the K1205 only for GSM A interface monitoring,
you can define the appropriate protocol stack as a standard.

The Autoconfiguration Wizard is located in → Tools → Autoconfiguration
Wizard.

Figure 13: Autoconfiguration Wizard (one of the dialog windows)
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Manual Configuration

To configure the K1205 manually, follow these general steps:

1. Switch to the Cards Overview in the Data Flow window (refer to
Figure Card Overview). Use the Cards Overview tab on the lower left
part of the screen.

NOTE. <ALT+A> and <ALT+M> are the easiest way to switch between
Cards Overview and Measurement Scenarios View.

The installed interface cards will be displayed graphically. The
following figure shows the display for one DS1/E1 monitoring board,
one Ethernet board, one BAI board, and one V./X. board.

Figure 14: Card Overview window
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2. Click on  to enter the dialog for the settings of the interfaces.

3. Enter the physical settings for your connected links. The dialog varies
depending on the installed cards.

For example, choose E1 or DS1 frame type, impedance, and line code
for the DS1/ES1 card.

Names for the ports can be assigned here, too. The default values
match the imprint on the interface.

NOTE. The Additional Processor Board (AP-4) is a single slot card that
increases the K1205’s processing power by a factor of 5 to 10 depending
on the application. When using 3 or more measurement cards it is
recommended to include the AP-4 card; it is necessary when using 5 or 6
boards in the K1205 Plus.

The new Ethernet board (ETH) is equipped with four 10BaseT or
100BaseT ports and supports full and half duplex mode.
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The following screenshots show port configuration examples:

Figure 15: Port configuration, properties for a DS1/E1 monitoring board

Figure 16: Port configuration, properties for an Ethernet board
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4. Confirm the settings and switch back to Measurement Scenarios (click
the other small tab on the lower left part of the main screen).
Now that the ports are set up, the K1205 has stored the characteristics
of the signaling traffic. The next step is the definition of the logical
links, which indicate where to expect the signaling and how to decode
it (defined by the protocol stacks).

5. LMC on the Online Scenario button (refer to Figure Logical Link
Setup) for the Logical Link Setup dialog window.

Figure 17: Logical Link Setup

The dialog window looks different depending on the chosen interface.
A few of the main settings are defined in the following list:

� Monitor in Tx and Rx direction (with identical or different settings)

� Edit the name of this link for better overview later in the Monitor
window. The chosen name will be displayed there.

� Choose correct protocol stack for decoding the signaling traffic

� Choose the correct timeslot (default is TS 16) and subslots if
available

After defining one link, you can create more settings until all your
connections are defined.

If you want to create a new logical link with settings identical to an
existing one, select the appropriate logical link in the Logical Links of
Scenario list. Then click New. Another way is to press <ALT+N> or
<Insert>.
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Figure 18: Logical Link configuration, example for a DS1/E1 interface

Figure 19: Logical Link configuration, example for an Ethernet board
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Figure 20: Change the scenarios

Logical links may also be defined or added by RMC in the Scenario
list. Press RMC in the left part of this window to access the context-
menus to add/remove/rename/change the online and offline scenarios.
Refer to section Scenarios and Figure Logical Link Configuration
(DS1/E1 Board).

With these settings it is possible to start the measurement. Activate the
pipeline (refer to section Configuration):

6. Switch to the Monitor window by clicking on 

By default, the Monitor icons are identified serially numbered. This
identifier is also displayed in the title bar of the Monitor window
(monitor name) . To change the monitor name, press RMC on the
Monitor icon and click Edit Monitor Name.
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Saving and Loading Configurations

You can save configurations in setup files. You can save any number of
configurations and load them individually as required.

How to Save the Current Configuration 

Proceed as follows:

1. Choose → File → Save System Configuration 
or File → Save System Configuration As 
or press <CTRL + S>

2. The Save dialog opens and the c:\k1205\config  directory is displayed.
Enter the desired name for the configuration file. The file extension
(*.s) is added automatically

3. Confirm your entries with Save.

NOTE. The system only saves settings for the currently installed interface
cards. Information about previously installed interface cards is lost, if you
load a configuration with hardware settings that do not correspond to the
current installation and save this configuration again.

The last used configuration is loaded automatically 30 seconds after the
measurement software is started. During these 30 seconds, a dialog is
shown with which you can start the autoconfiguration or another setup file.

NOTE. If the system cannot detect a saved configuration, the default
configuration is activated.

It is also possible to load a saved configuration (setup file) at a later point
of time, such as after completing a measurement in order to begin a new
one with different parameters.
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How to Load a Saved Configuration 

1. Select one of the setup files from the pick list in the File menu 
or choose → File → Open System Configuration 
or press <CTRL+O>. 

The Open dialog appears, and the directory c:\k1205\config  is
displayed.

2. Select the desired configuration file.

3. Confirm your selection by selecting Open.

Either accept the configuration as is or change the settings before starting
a measurement.

NOTE. If an error occurs while the system is loading a setup file, the most
recently loaded configuration is reactivated.
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Auto Restart

The K1205 will restart (such as after a power failure) with the last saved
configuration (refer to section Saving and Loading Configurations) or the
default configuration if you did not save a configuration.

When running un-monitored long-term measurements, measurement data
may be saved in a recording file. If the measurements are interrupted by a
power failure, for example, you may automatically continue with the
measurement after restarting the K1205.

1. Set up a Long term measurement

2. Configure the measurement with an online recording pipeline.

3. Save the configuration.

4. Start the measurement.

NOTE. To autostart your K1205 after a power failure, select Start the
K1205 application at every system start-up in the K1205 setup program.
This copies the K1205 program into the Autostart folder of WinNT. This
may also be done manually if you want to change it after installation.
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Monitor Window
The Monitor window displays measurement data that is currently received
or played back from a file. 
The titelbar of the Monitor window shows the type of scenario (e.g.
Online/Offline), the monitor name, and the data source. To change the
monitor name, press RMC on the Monitor icon in the pipeline and click
Edit Monitor Name.
The display of the data is split in three panes with different display levels:
Short View, Frame View, and Packet View. You can control these windows
by dragging the frames and hide or show them with the buttons

 (refer to chapter Appendix).

Short View

Frame View

Packet View

Figure 21: Monitor window
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LIVE Mode and FREEZE Mode

Incoming frames are displayed immediately (live), 
and the screen scrolls automatically.

Scrolling is performed manually with the cursors.
Freeze mode suppresses the continuous display of new 
data allowing a more detailed analysis of frames.

Switch between Live Mode and Freeze Mode with the buttons in the
toolbar. Freeze is activated automatically when you open the Monitor
window during a live measurement.

Frame View, Packet View and Short View

Frame View. The frame selected in the Short view is shown in the Frame
View window pane. Here, it is displayed completely decoded down to the
bit level. The first column shows the selected octet, the second column
shows the name/meaning of the octet, and the third column shows the
comment or value of the parameter. The protocol stacks loaded with the
scenario determine which protocol parameters are shown.

Display level and color of the protocols can be changed in the Frame View
for a better overview (RMC, Monitor Setup, Display Level or Colors of
Protocols, or use the toolbar button ).

NOTE. When scrolling through the Frame View with the cursor keys, the
scrolling will stop at the beginning or end of the marked frame. To switch
to the previous/next frame press <CTRL+↑> or <CTRL +↓>.
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How to Set the Display Level. To set the display level within the Frame View
window pane, proceed as follows:

1. Select the desired protocol.

2. Select the desired level. The Level list box indicates the display level
currently assigned to this protocol. The description file (.upd-file)
assigned to the protocol determines which display levels are selected
and which parameters are displayed:

� Complete: display all protocol parameters 
(shortkey CTRL+9>)

� Medium 1,2...: display some protocol parameters 
(shortkeys <CTRL+1, CTRL+2>)

� Layer Only: reduced representation 
(shortkey <CTRL+0>)

� Hidden: no protocol parameters displayed

To define the display level for further protocols, repeat these steps.

3. Confirm your settings with OK.

NOTE. The display level setting for a specific protocol is applied to all
open Monitor windosw.

Figure 22: Display Level window
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Packet View. The Packet View window pane displays the frame selected in
Short View in HEX or ASCII, HEX plus ASCII, Binary, or EBCDIC. If
you select an individual protocol parameter in the Frame View, the
corresponding values are highlighted in the Packet View matrix (refer to
the online help for further details).

Short View. This Short View window pane lists the data packets (frames)
recorded by the K1205, displaying signaling data in single rows and short
form. The preset columns display the time stamps, logical links, protocol
names, and messages of levels 2 to 4.

You can assign specific foreground and background colors to each logical
link for a better overview. Assign the color settings when creating the
logical link settings (refer to section Manual Configuration) or when
opening a recording file. You can also change the settings by clicking the
buttons Setup or Change in the pipeline (refer to Figure Recording File
Write Configuration window).

Figure 23: Short View with colored logical links (gray scaled)

All data events and error messages of the logical link are displayed with
these color settings in the Monitor window.



Monitoring with K1205 Version 2.30

28 K1205 V 2.30 Short Introduction

Column Configuration

The Short View lists the recorded data frames (data packets) in short form.
The preset columns display the time stamps, logical links, protocol names,
and messages of levels 2 to 4.

Figure 24: Column Configuration for Short View
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With RMC Column Setup or  in the Monitor window, you can change
the setup of the number and type of the columns in the Short View.

To display/remove the Release Cause in an ISUP connection, proceed as
follows:

1. RMC Column Setup.

2. Scroll in Available Columns down to REL cause and select the entry
(more entries may be selected if desired).

3. Click the Add/Remove  button. The column will be moved to Selected
columns.

You can move a selected single entry up and down by pressing the Up
and Down buttons.

4. Confirm with OK. The Short View is updated and the new parameters
are displayed.

You can also save the column configuration, allowing increased flexiblity
in analyzing data in the Short View. Use the Save and Load buttons for
this. The files will be saved with the extension .mcc.
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Zoom Function

You can use the zoom function  to display all messages for a single
connection, for example ISUP: CIC; SCCP: reference number;
TCAP: Transaction ID or IP MGCP: CMD/RSP Call Id; 
ISDN: SAPI/TEI/Callreference.
The zoom function does not affect your display filter setting.

To activate zoom, use toolbar button , RMC Zoom, or press z; 

to undo zoom, use toolbar button , RMC Zoom again, or press
<SHIFT+z>.

The zoom function is currently available for GPRS, IP, ISUP, TUP, ISDN,
SCCP (BSSMAP/DTAP), MAP, and INAP protocols.

Figure 25: Zoom results

Depending on the protocol a window opens for setting the zoom
parameters:

Figure 26: ZOOM Filter Configuration window
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SPC/CIC Grouping

Using the K1205 for international traffic makes it necessary to adapt the
SPC/CIC to the appropriate lengths and formats. To change the display,
use RMC Monitor Setup, SPC/CIC Grouping.

Figure 27: SPC/CIC Grouping definition

You can set the SPC Length to 14, 16, or 24. These options specify the
number of bits used for the signaling point code of filter inputs.

The selected SPC length determines the selection options in the list box
SPC Grouping. Use these settings for the SS#7, GSM and IN protocol
stacks.
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If the SPC length does not match the data, the K1205 cannot decode the
messages properly. The SPC Grouping setting affects only the display, and
the number of bits must correspond to the actual SPC length.

You can choose the grouping from the predefined settings, or you can
define custom needs (Edit button).

NOTE. The setting in the Monitor window is temporary. To attach an
SPC/CIC setting to a protocol stack, define SPC/CIC in the Protocol Stack
Editor (refer to section Protocol stacks) with RMC Monitor Setup, Monitor
Setup, SPC/CIC Grouping, and then check the Save to Stack File box.
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Timestamps

The K1205 assigns a time stamp to each event received, indicating the
time of reception. The stamp has the format hh:mm:ss:ms:µs. In Freeze
Mode, it is possible to evaluate this difference between single events.

To analyze the time difference between two recorded events, switch to
Freeze Mode.

Select the event in the Short View that is to serve as the reference point of
the difference calculation and press F9, or select Monitor → Reference for
Timestamp → Set. 
Select the appropriate timestamp format (see figure below).

Figure 28: Timestamp format

The event set as the timestamp reference remains highlighted and is now
indicated by the following anchor symbol.

Now select any other frame in the Short View to see the time difference.
The frame number of the reference point, currently selected frame number,
and timestamp difference (+/-) are displayed in the status line at the
bottom of the Monitor window.
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Figure 29: Timestamp data

The Time difference field indicates the difference in hh:mm:ss:ms:µs. A
negative difference appears, if the starting point event occurs before the
reference event.

Save or Print Marked Frames

The contents of the monitor or capture RAM may be saved or printed as
decoded ASCII text or written undecoded in a K1205 recording file. ,

1. With RMC in the Monitor window you can choose between Save
Marked Frames As... and Print Marked Frames.

2. Desired frames can be marked/selected by pressing <SHIFT> and
dragging the mouse.

NOTE. The Find option jumps only to matching frames, and the Filter
option hides all non-matching messages.
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Filter
Start the filter dialog in the monitor pipeline by LMC on the symbol. You
can either use the Filter before the Capture RAM or before the monitor
application.

Depending on the stack, different filters in the data flow diagram are
displayed at the bottom of the window (yellow and green) when changing
the settings.

Figure 30: Filter Setup, Protocols tab
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Example

Example of filtering an ISUP connection for all Release messages with the
Release Cause Normal Call Clearing (use the file wbisup.rf5 that comes
with the software):

1. Click on the Filter symbol in the pipeline.

2. Click Reset to put the filter in a defined mode, and verify that the
bypass option in the lower part of the dialog is unchecked. 
This box will automatically become unchecked once a filter is properly
configured and activated.

3. Select the Protocols tab. Uncheck the Bypass Protocol Filter box in the
top left corner of the tab.

4. Press No Protocols below the Protocols pane. ( No Protocols is a
context-sensitive button that might appear as All Protocols. If not yet
active, press the All Protocols button, first).

5. In the Protocols pane select ISUP (if the marker turns green, press No
Messages below the Messages of ... pane).

6. Scroll down, and select REL in the Messages of ... pane (if the marker
turns green, press Ignore Message below the Messages of ISUP pane).

7. Enter cause in the Search for field and press Search three times.

Parameter Cause Value will be marked in the Parameters of ISUP/REL
pane.

8. Press Edit. The Edit Parameter Value dialog box appears.
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Figure 31: Edit filter parameter values

9. Select Normal Call Clearing at Predefined Values 
or choose Dec at Value(s) and enter 16 in the field directly.

10. Press OK and check the box of the parameter Cause Value and confirm
with OK. The monitor will be updated and only the selected REL
Message will be displayed. Note that errored events will also be shown
unless they are filtered out.
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K1205 version 2.30 has widened your possibilities to enter and edit filter
parameter values.
If you want to enter a value range, select the Dec, range format. A range is
represented as a set of two values in square brackets separated by a dash.

Figure 32: Editing value ranges

To enter parameters of MAC, IP4 , and IP6 in grouping format as shown in
figure 33 below.

Figure 33: Editing values in Hex, grouped format
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K1205 version 2.30 checks for correctness of the entry in the Value(s)
field. A yellow mark will appear, if size or range of the value are
incorrect; in case of a syntax error the mark will turn red.

Figure 34: Warning information: Entered value is above maximum

NOTE. Filter configurations can be saved and loaded in separate files with
the extension .flt. You can also copy one filter configuration to another via
the system clipboard with the commands Copy and Paste. RMC on the
Filter symbol in the pipeline.

You can reset a filter configuration with one click or disable the filter
configuration temporarily by activating the Bypass checkbox in the filter
dialog.

The Bypass function is displayed graphically in the pipeline. If a filter is
configured, its pipeline box shows a bold font. If it is bypassed, the
graphic shows a wire that goes around the filter.
To quickly activate /deactivate the Bypass function, press <CTRL + b>.

NOTE. Filters are set to Bypass by default. This allows the K1205 the
fastest operation. To activate a filter, make sure the Bypass box is
unchecked.
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Expert Mode

Figure 35: Filter Setup tab Expert Mode

The new Filter Setup tab Expert Mode gives you full control on logical
relations of filter settings.

By default, the Current configuration box is set to read-only (see example
above). The script in this box shows the configuration as set in the other
tabs of Filter Setup.
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To edit the filter configuration in expert mode, click on Enable user
defined configuration. Now, you can insert, edit, or delete expressions in
the Current configuration box.

NOTE. Once Expert Mode is enabled via clicking the Enable user defined
configuration  box, all other filter pages are deactivated. To reactivate
those pages press Reset. This operation discards all  unsaved configuration
settings.
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Trigger
You can use the triggers to control measurement processes. A trigger
connects an event with a predefined action. As soon as the event occurs
(the trigger condition is fulfilled), the action is carried out. An event could
be the receipt of a specific message. A trigger action could be the display
of a user-specified message.

The settings of a trigger always refer to the data source (source or
recording file) of the respective pipeline. Depending on the trigger
definition, the trigger conditions could apply to the entire pipeline or to
individual branches.

The configuration of triggers is similar to the configuration of the input
filter, but a trigger lets all data frames pass through. If a specific data
frame is received (an ISUP IAM) or a specific system state is reached (a
certain point in time), the predefined action is carried out (termination of
the measurement).

To configure triggers, click the trigger pipeline element.

Trigger element

Figure 36: Trigger pipeline element

Trigger settings are saved in the configuration file (refer to section Saving
and Loading Configurations).

The following example explains how a trigger works. The trigger in this
example (ISUP) accomplishes the following tasks:

� Triggers an IAM for a specific call number.

� After this specific IAM has been received, a recording file starts.

� The recording stops after one hour.
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These tasks are graphically represented in the Trigger Configuration
dialog as follows:

Figure 37: Trigger Configuration

The following is required for the configuration of the trigger:

� An Online Recording pipeline must be configured.

� In the corresponding data source, a logical link must be configured
with a channel where signaling takes place.

� A recording file must be configured into which the data are written.
Select Create and Close multiple files automatically as recording mode
and a file size that will not limit the recording.

In order for the trigger to accomplish the tasks, two trigger conditions and
three trigger actions must be defined. To create a relation, simply click and
drag the condition to the desired action.



Monitoring with K1205 Version 2.30

44 K1205 V 2.30 Short Introduction

To change the order of the actions, LMC on each box in the action column
to clear the order number; next, LMC on each box in the desired order of
execution.

Figure 38: Trigger configuration
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Trigger Condition 1

Protocol Filter: 
The trigger must be configured to recognize the IAM. In order to detect
the IAM, the appropriate protocol filter must be set as a trigger
condition.

Two actions are linked to this condition.

Trigger Action 1: 
Close the pipeline branch in which the recording file is configured.

Trigger Action 2: 
Enable trigger condition 2: Time Trigger.

Trigger Condition 2

Time Trigger: 
The data recording is to be terminated after one hour. To enable this
function, a time trigger must be defined with a time period of one hour.
As soon as this period has elapsed, the third and final action is carried
out.

Trigger Action 3: 
Open the pipeline branch in which the recording file is configured.

NOTE. After conditions/actions configuration, always enable the trigger
before closing the trigger window.
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Applications
The K1205 software package includes applications for performing a wide
variety of problem-based evaluations of signaling data. 
These applications are separate measurement programs and help, for
example, analyzing protocol-specific information.

Overview

The available applications are:

� Abis Monitor
Monitor and graph Abis-Interface parameters such as RXLEV,
RXQUAL, MS/BTS Power, Coverage, Interference, and Island.

� CallMon (Traffic and Call Analysis)
Creates an extensive statistical analysis of calls on all TUP (incl.
BTNUP) and ISUP protocols. Analyzes up to 10 different telephone
numbers or areas of telephone numbers (e.g. all calls to Germany).

� CallTrace / Sequencer 
Traces and recognizes calls on the basis of a partially specified or
complete call number.

� Decipher
Enables you to decode online an offline ciphered  data on GPRS Gb
interface by recognition of IMSI and Kc parameters. For further
details, see section GPRS Monitoring / Decipher.

� GPRS Gb Mon: 
Creates an extensive statistical analysis of calls on GPRS protocols.
For further details, see section GPRS Monitoring / GPRS Gb Mon.

� GPRS MM/SM Statistics
Classifies and counts the received signalling data. For further details,
see section GPRS Monitoring / GPRS MM/SM Statistics.

� IP Traffic Analyzer
This application shows active communication flows characterized by
IP addresses or specific protocol features over an IP network at high
level. The user can configure the filter object in the K1205 main
application to monitor only the IP traffic of interest.
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� Nortel Frame Number
This application calculates the frame number contained in the data
flow of GPRS Nortel-type protocols.

� PCR Suppression
Enables you to filter out repeated MSUs by means of the preventive
cyclic retransmission procedure.

� Service Profile Statistics
Provides you with an overview of the IP-based TCP and UDP
protocols’ service profiles.

� Statistic 
Classifies and counts the received signalling data on the basis of
different, changeable criteria. Graphical and alphanumerical evalua-
tion.

The following predefined statistical applications can run without extensive
configuration:

� BHCA - Busy Hour Call Attempts: 
Counts the call attemps within a specified time period.

� Count All: 
Classifies and counts the received messages sorted according to
protocols.

� Erlang Measurement: 
Measurement of the signaling load on the logical links.

� TCA - Traffic Channel Analysis: 
Analyzes a signaling channel and evaluates the traffic channel
assignment.

These applications display their results in tables or graphically using
RealChart. The results can be saved and exported to various database or
spreadsheet applications.

All applications included with the K1205 are located in the c:\k1205\app
directory.
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1. Start any application by pressing the Application  pipeline element,
selecting the desired function, and pressing OK.

Figure 39: Load / Unload Application Programs

All applications can be initialized while the pipeline is inactive.

Run Two Applications in One Pipeline

It is possible to run two applications in one pipeline at the same time.
Uncheck the Single Mode box. This activates the right right part of the
window shown above. 
Select the appropriate function and click on Load / Unload. Loaded
functions are now shown in the list box on the right. To start the
applications, press OK.
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Abis Monitor (AbisMon)

This application gives a statistical evaluation of the Measurement Report
messages on the Abis-Interface.

AbisMon monitors the parameters of the Abis-Interface, such as RXLEV,
RXQUAL, MS/BTS Power, and creates graphical results such as
Coverage, Interference, Island.

Figure 40: Abis Monitor results
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Busy Hour Call Attempt Statistics

The Busy Hour Call Attempt (BHCA) application counts all the call
attempts (IAM Messages) and calculates the number of call attempts
within hours or days to get an overview of the call traffic on the connected
lines.

CallMon (Traffic and Call Analysis)

This application creates an extensive statistical analysis of calls for ISUP,
TUP, ISDN, and Abis protocols.

CallMon analyzes up to 10 different telephone numbers or areas of
telephone numbers (e.g. all calls to Germany). Results are stored in a
.csv-file  which can be viewed and processed using MS EXCEL. The
following parameters are created: Successful / non successful calls,
average hold time, average conversation time, average PDD, ASR[%],
Calls Res. in Alert[%], Calls Res. in Disconnect[%], and a number of the
different Release Causes.

Figure 41: CallMon results viewed in MS Excel
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Calltrace and Calltrace Sequencer

This application is available for 
GPRS Gb, GPRS Gn / Gp, GPRS Gr / Gc, IP MGCP (Sequencer), ISUP,
Abis and A-Interface (GSM900, GSM1800, PCS1900 and CDMA), INAP,
ISDN, and TUP, depending on the software package(s) purchased.

Select this application (LMC on Application  in the Pipeline), click on the
appropriate protocol, and choose the desired number, parameter, or values
(such as CalledPartyNumber, TMSI, Release Cause, etc.) depending on the
protocol used.

Figure 42: SWISSCOM ISUP Calltrace
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You can set the Filter Mode to suppress frames if you want to see only
those messages that belong to the traced calls. All other frames will be
suppressed. The more precisely the trace numbers are specified, the more
precise the filter can be. The text strings generated by the Calltrace
application are completely displayed in the Short View.

Figure 43: SWISSCOM ISUP Calltrace Cause Value

Four comma-separated numbers can be traced simultaneously. Each of the
numbers can contain the wildcards *, ? and + anywhere in the number.
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Start the measurement by LMC Start, and the result should be similar to
the following illustration:

Figure 44: Example of a calltrace-result (detail)

Sequencer Application. The Sequencer application of the K1205 simulta-
neously sorts all call related frames for up to 1000 ISUP connections. With
the trace mode activated, one will get additional trace information about
each call. Outputs are similar to the following illustration:

The sequencer evaluates calls as follows: the beginning of the message is
the IAM and the end will be the RLC - or a timeout in case there is no
RLC detected.
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Call Detail Records.  The CDRs application creates detailed call information,
like the called / calling party number, call duration, hold time, wait time,
response time, etc. Results are written into a CSV file (Comma Separated
Value).

1. To activate the CDRs application, click on the Generate Call Detail
Records (CDRs) box under Application work mode.

2. Select the CDR tab. Determine the Filemode: Choose Overwrite if you
want to create a new file or overwrite an existing file. Choose Append
if you want to add further data to an existing CSV file.

3. Click . The directory C:\K1205\log opens. Create a new CSV file,
or select an existing one.

4. If required, make additional settings on other tabs and start the
Calltrace / Sequencer.

Figure 45: CDR tab



Monitoring with K1205 Version 2.30

K1205 V 2.30 Short Introduction 55

Count All

This application counts all the received messages and sorts them according
to protocol and message type.

The following diagram shows the Overview results.

Figure 46: Count All Overview results

Messages can also be sorted by specific protocol within a protocol stack.

Figure 47: Count All results for a specific protocol (ISUP)

Erlang Measurements

This application calculates the load for each logical link of the pipeline.
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IP Traffic Analyzer

The IP Traffic Analyzer maintains two views of communication in real
time:

� IP View organizes the traffic by IP connection (i.e. between 
computers).

� Protocol View shows traffic organized by protocol layer (i.e. TCP,
UDP, SCTP, M3UA, etc.), and then shows the IP addresses of the
computers involved.

Therefore, the tool supports configurations for GPRS and GPRS_IP with
GB_IP (NS_IP) and Gn with GTP; IPS7 (MAP_IP over SCTP) as well as
VoIP systems running MGCP and SIP.

Host names are resolved from IP addresses by file hosts.txt. This file is not
required, but if available, a text host name will be displayed instead of an
IP address.
Sample of a hosts.txt file:

128.181.52.216 plccontrol1
128.181.117.254 amcemulator
128.181.141.162 w-meetab01
128.181.238.28 dhcp238-28
128.181.21.36 t-train06
128.181.39.71 jamaica13
128.181.239.6 dhcp239-6
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Figure 48: IP Traffic Analyzer - [IP View]
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Nortel Frame Number

The Nortel Frame Number application can only be used for GPRS
Nortel-type protocols.

It calculates the frame number (FN) implicitly contained in the data flow
from the following parameters in the data flow:

� Multi frame number (MFN)

� Block number (BF)

� Number of idle bursts (Nib)

The calculated frame number (FN), status and error messages are fed into
the pipeline as text messages and can be evaluated in the monitor.

PCR Suppression

The PCR Suppression application enables you to filter out repeated MSUs
from an offline pipeline by means of the PCR procedure (preventive cyclic
retransmission).

You may want to remove these messages in order to obtain a smaller
amount of data consisting of relevant data. The application can be applied
for all MTP-based protocols.
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Service Profile Statistics

The Service Profile Statistics application provides you with an overview of
the IP-based TCP and UDP protocols’ service profiles used in a network.
Open the Application  Window in the pipeline with LMC, and select
Service Profile Statistics.

The availability of the specific protocol layer, i.e. either TCP or UDP, in
the protocol stack is a condition for the use of the application.

Determine the statistics to be displayed in the Service Profile Statistics
output dialog box. To add or modify services to the Statistic Output list,
press Select output ... . The Service Profile Output Configuration window
appears.
Select the desired service from the Available Services list on the left and
press Add. The new service to be measured will now appear in the
Selected Services list on the right.

Figure 49: Service Profiles Configuration
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Statistic

In the Statistic setup you can define your own counters based on specific
protocols, logical links, errors, and/or frame lengths. Open the Application
Window in the pipeline with LMC, and select Statistic.

The Statistic window will open. Here you may define counters (RMC) for
the desired events, messages, and so forth. They will be calculated and
displayed as defined in the RealChart setup. Files can be saved in several
formats.

The Statistic application allows you to evaluate and graphically display
received signaling data or data from a recording file in real time. For each
message that you want to evaluate, you can define a counter that counts
messages of this type as they are received. You can also set counter limits
(upper and lower limits) that cause a specific trigger action. The K1205
reads and displays the value of each defined counter on the screen at
adjustable time intervals. The counter is then reset, and the next interval
starts.

RealChart displays the current counter states and also allows you to view
measurement data in tables or graphical diagrams in real time. You can
combine several counters in one table or diagram. All counters in a
diagram belong to a group, of which several can be defined.

Figure 50: One of several output formats of the Statistics application
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TCA - Traffic Channel Analysis

The Traffic Channel Analysis (TCA) application analyzes a signaling
channel. The traffic channel (basic channel) assignment controlled by this
signaling channel is evaluated. The application supports all ISUP, TUP, BT
NUP protocols.

For configuring the Traffic Channel Analysis application proceed as
follows:

1. Click the applications element in the pipeline.

2. Select TCA in the Select Application Program dialog.

Two lists in the TCA dialog display the protocol stacks assigned to the
data source/recording file and the available protocols in these stacks.

3. Select the desired protocol stack in Available stacks.

The Available protocols list now displays the protocols (from this
stack) that may be monitored.

4. Select the desired protocol.

5. In the Refresh rate field, specify a time period in which the measured
values are to be displayed.

The RealChart tool displays the results of the Traffic Channel Analysis
application in tables and diagrams. The table provides two display formats
for the recorded data:

� Currently used Channels: Provides an overview of the number of
currently used traffic channels per PCM. The monitored PCM links in
this overview are organized in groups of 16.

� Max. used Channels: Provides an overview, displayed in lines and
sorted according to time periods, of the maximum number of used
traffic channels for each PCM link. The values are displayed in a
separate column.
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To switch to the display of bar charts, select Diagrams → Max. used
Channels → Bar in the context menu, and choose the desired group of
time slots.

Figure 51: TCA output of Max. used channels
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Tools
PCM Check

The PCM Check automatically detects and displays the type of signalling
received on connected E1/DS1 links. Connected traffic to whether
signalling in SS#7, LAPD /LAPV, Abis or TRAU is running on E1/T1 is
detected automatically. This check is located in the menu Tools →
PCMCheck.

Figure 52: PCM Check

The PCM Check is useful only if the K1205 is receiving real data over the
interfaces. It can be used to provide a quick overview of the channel
assignments within a PCM frame. An explanation of the symbols can be
found in the K1205 Help application.
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Load-Meter

While running measurements, you can use the Load-Meter program which
provides capacity usage information on individual K1205 interfaces and
the PC card.

In case of an overload situation (too much traffic on a link) the display
will contain red bars.

Figure 53: Load-Meter

NOTE. If several interface cards are installed on the K1205, it is best to use
all cards except for the first one to receive data. The system uses the
memory area of the first card to manage the specified configuration. This
configuration allows the optimum load distribution even when running the
links at a high load.
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GPRS Monitoring

Features
K1205 v2.30 provides the following features:

� Deciphering on GPRS Gb- interface (up to 1000 subscribers)

� Extensive GPRS statistics (network/cell-, subscriber-, service- based)

� Measurement of QoS parameters (delay, throughput)

� GPRS call trace capability on Gb-, Gn-, Gp-, Gr-, Gc- interface

� Monitoring of all GPRS Gx-interface (Gb, Gn, Gi, Gs, Gr, Gf, Gc, Gd,
Ga)

� Monitoring of a huge number of vendor specific GPRS Abis interfaces
(Alcatel, Ericsson, Lucent, Motorola, Nokia, Nortel, Siemens)

� Monitoring of all protocol layers regarding signaling and transmission
plane including a huge number of protocol versions of Rel. 97, Rel. 98
and Rel. 99

� Technology Interworking
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General
As the specifications for GPRS are still subject to changes, different
versions of protocols will be delivered. All GPRS related protocol stacks
can be found in the directories c:\k1205\stacks\gprs and
C:\K1205\stacks\ip_gprs

The nomenclature follows the following rule:

gprs_<interface>_<smg#>.stk

Thus, gprs_gb_29.stk is the protocol stack for the Gb-interface according
to SMG#29.

For the Abis-interfaces the following rule applies:

Abis_<manufacturer>_<smg#>_<u/d>.stk

So, abis_xyz_smg29_u.stk  should be used for monitoring the Abis-inter-
face of company XYZ in Uplink.

Logical Link Configuration for the Gb-Interface

The protocol stack for the Gb-interface is based on Frame Relay (FR) on a
PCM30/PCM24 line. Frame Relay supports three different modes offering
a bit rate of 8 kBit/s to 1984 kBit/s.
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Channelized Mode. Each Frame Relay Bearer channel has a bit rate of 64
kBit/s.

Unchannelized Mode. The complete PCM line forms a Frame Relay Bearer
channel offering a bit rate of 1984 bit/s for E1 lines (31 times 64 kBit/s,
timeslot 0 is used for synchronization) and 1536 kBit/s for DS1 lines.



GPRS Monitoring

68 K1205 V 2.30 Short Introduction

Fractional Mode. Using the fractional mode, any bit combination may be
used to build a Frame Relay Bearer channel.

The K1205 does support all of these three Frame Relay modes. In order to
be able to monitor an Unchannelized or Fractional Frame Relay connec-
tion, each card / interface has to be configured for the so called Special
Mode.

1. Therefore select menu item DS1/E1 Default Start Mode from the Tools
menu.
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The following dialog appears:

2. Select the Special Mode, press the OK button, quit the K1205
application, and start it again.

The interfaces will now work in the special mode and you will be able
to select the Fractional Mode as level 2 method in the Logical Link
Configuration dialog. To change the cards back to the Standard Mode,
simply change the setting in the dialog and restart the K1205
application.



GPRS Monitoring

70 K1205 V 2.30 Short Introduction

Restrictions

� While the Standard Mode supports the configuration of up to 64
unidirectional (32 bi-directional) logical links with a bit rate of 64
kBit/s each, the Special Mode supports up to 16 unidirectional 
(8 bi-directional) logical links.

� Each bi-directional unchannelized Frame Relay connection takes away
four unidirectional links, thus a total of four unchannelized Frame
Relay connections can be set up for one DS1/E1 Monitoring board.

Channelized, fractional, and unchannelized Frame Relay connections
could be mixed on one DS1/E1 Monitoring board, taking into account
the maximum number of logical links in Special Mode.
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GPRS Applications
K1205 V 2.30 includes the following new features for GPRS measure-
ments:

� Deciphering on GPRS Gb interface

� Extensive GPRS statistics (network/cell-, subscriber-, service- based)

� Call Trace on different GPRS interfaces

� GPRS Monitoring of all GPRS Gx interfaces
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Decipher (Deciphering on GPRS Gb Interface)

The deciphering application on K1205 enables you to decode online and
offline ciphered by recognition of IMSI and Kc parameters.

Transmission of ciphered data between GPRS terminals and the network is
becoming more and more crucial for GPRS network operators. Whenever
enciphering is switched on in GPRS networks all signaling data and
payload above the protocol layer Logical Link Control (LLC) are
encrypted. The deciphering application on K1205 enables you to decipher
these data and thus carry out analysis and processing of all data above the
LLC protocol layer.

GPRS Encryption Algorithm 1 and GEA 2 are supported. Deciphering can
be run both in online and offline mode. The deciphering solution supports
3 operation modes:

� Full Automatic Mode 
Automatic recognition of up to 1000 IMSIs and their corresponding Kc
value(s) at the same time.

� Half Automatic Mode
Automatic recognition of all Kc value(s) after manual input of up to
1000 IMSIs.

� Manual Mode
Manual input of up to 1000 IMSIs and their corresponding Kc value(s).
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The diagram below shows configuration of Half Automatic Mode in the
Decipher configuration box:

Service Profile Statistics

The Service Profile Statistic application displays an overview on the
actually used services in a GPRS network (e.g. HTTP, FTP, WAP).

For further details, see section Applications / Service Profile Statistics.
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GPRS MM/SM Statistics

The application GPRS MM/SM Statistics provides statistical information
on attaches, PDP context procedures and service profiles on the GPRS Gb
interface.

The selectable statistical output depends on specific layers in the protocol
stack: Both Attach Overview and PDP Context Overview require that the
GMMSM layer is part of the stack, Service Profiles requires the TCP layer.
Results can be displayed using Real Chart or can be stored in a .csv-file

� Attach Overview states the relation between the requested connection
setups (attach request) and those that are accepted (attach access) or
rejected (attach reject).

� PDP Context Overview shows the temporal course of the PDP context
connections. The following values are displayed: PDP context request,
PDP context accept, PDP context reject, PDP context modification.

� Service Profiles show, in the temporal course, which, and to extent,
services are demanded. The following services can be displayed:
WAP, SMTP, POP3, HTTP, FTP.
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GPRS-Gb Mon

This application gives you detailed information about all attach / detach
procedures and PDP context procedures. Results are displayed in a Session
Overview window and can be stored in a .csv-file.

Session Overview displays the following settings for each event: 
Number (No.), Temporary Logical Link identity (TLLI), International
Mobile Subscriber Identity (IMSI), International Mobile Subscriber
Identity (IMSI), Temporary Mobile Subscriber Identity (TMSI), Packet
TMSI (PTMSI), Connection State, Source IP Address, Destination IP
Address, PDP Contexts, Current Cell ID.

Further details of a selected event are shown in the Detail View window.

Calltrace Capability on Gb, Gn, Gp, Gr, and Gc Interfaces

While monitoring different interfaces of a GPRS network, it is often
necessary to limit the data stream to the information from only one or a
group of subscribers. Powerful calltraces on GPRS interfaces provide this
possibility. GPRS calltraces are now possible on the follwing interfaces:

� Gb interface

� Gn / Gp interface

� Gr / Gc interface

For further details, see section Applications / Calltrace and Calltrace
Sequencer.
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Appendix A: Command Buttons

Table A–1: Command Buttons 

Button Meaning Button Meaning

Data Flow Window (main
screen)

Protocol Stack(s)

Monitor Window(s)

Add Online Monitoring
Pipeline

Add Online Recording
Pipeline

Add Online Statistics
Pipeline

Add Offline Monitoring
Pipeline

Add Offline Recording
Pipeline

Add Offline Statistics
Pipeline

Maximize Frame View Minimize Short View

Minimize Frame View Minimize Packet View

Display in Live Mode Display in Ring Mode

Arrange Icons Cascade Windows

Tile Windows (vertical) Tile Windows (horizon-
tal)

Show / Hide Pipeline Bar Status Window

Monitor Setup Change Column Configu-
ration

Go to first available
frame

Go to last available frame
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Table A–1: Command Buttons (Cont.)

Button MeaningButtonMeaning

Start Measurement Stop Measurement

Pause Measurement
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